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Указания по технике безопасности 

Данное руководство содержит указания, которые вы должны соблюдать для обеспечения 
собственной безопасности, а также защиты от повреждений продукта и связанного с ним 
оборудования. Эти замечания выделены предупреждающим треугольником и представлены, в 
соответствии с уровнем опасности следующим образом: 

 

!  
Опасность 
указывает, что если не будут приняты надлежащие меры предосторожности, то это приведет к 
гибели людей, тяжким телесным повреждениям или существенному имущественному ущербу. 

 

!  
Предупреждение  
указывает, что при отсутствии надлежащих мер предосторожности это может привести к 
гибели людей, тяжким телесным повреждениям или к существенному имущественному ущербу. 

 

!  
Осторожно 
указывает, что возможны легкие телесные повреждения и нанесение небольшого 
имущественного ущерба при непринятии надлежащих мер предосторожности. 

 
 Осторожно 

указывает, что возможно повреждение имущества, если не будут приняты надлежащие меры 
безопасности. 

  
 Замечание 

привлекает ваше внимание к особо важной информации о продукте, обращении с ним или к 
соответствующей части документации. 

Квалифицированный персонал 

К монтажу и работе на этом оборудовании должен допускаться только квалифицированный 
персонал. Квалифицированный персонал – это люди, которые имеют право вводить в действие, 
заземлять и маркировать электрические цепи, оборудование и системы в соответствии  со 
стандартами техники безопасности. 

Надлежащее использование 

Примите во внимание следующее: 
 

!  
Предупреждение 
Это устройство и его компоненты могут использоваться только для целей, описанных в 
каталоге или технической документации, и в соединении только с теми устройствами или 
компонентами других производителей, которые были одобрены или рекомендованы фирмой 
Siemens.  
Этот продукт может правильно и надежно функционировать только в том случае, если он 
правильно транспортируется, хранится, устанавливается и монтируется, а также 
эксплуатируется и обслуживается в соответствии с рекомендациями. 

Товарные знаки 

SIMATIC®, SIMATIC HMI® и SIMATIC NET® - это зарегистрированные товарные знаки SIEMENS AG.  

Некоторые другие обозначения, использованные в этих документах, также являются 
зарегистрированными товарными знаками; права собственности могут быть нарушены, если они 
используются третьей стороной для своих собственных целей. 
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Введение

Цель

Вы хотите установить наши SIMATIC S7 CP в Вашу систему и оптимально их использовать.

Как достигнуть Ваших целей

Этот пример поможет Вам познакомиться с обращением с NCM S7 для Industrial Ethernet,
инструментом конфигурирования для S7 CP. Основываясь на конфигурации и примерах
программ, поставляемых с NCM, мы познакомим Вас с типичными шагами, необходимыми
для оптимального использования продукта NCM S7 для Industrial Ethernet с Вашими SIMATIC
S7 CP.

Цель примера... ...как достичь цели
Вы хотите научиться, как
использовать продукт эффективно
в короткое время...

...проработав шаги, описывающие
использование поставляемого
примера с соответствующей
конфигурацией системы.

Вы хотите научиться, как
использовать продукт особенно
эффективно, затратив немного
больше времени...

...используя это описание как
поддержку при конфигурировании
(первый раз) и программировании
Вашего собственного приложения.

Требования

Вы д.б. знакомы с основами STEP 7, другими словами, Вы должны знать следующее:
• Как работать с STEP 7
• Какие функции предлагает STEP 7 для управления аппаратурой и
программами

• Как управлять проектами

Аудитория

Этот пример предназначен для пусконаладчиков и программистов программ STEP 7, а так же
для обслуживающего персонала.

Применение руководства

Этот пример применим для программного пакета конфигурирования NCM S7 версии 4.x и для
программного пакета STEP 7 версии 4.x.
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Дальнейшая информация...

Для дальнейшей информация о документации по STEP 7 и продукте обращайтесь, пожалуйста,
к прилагаемому руководству “NCM S7 для Industrial Ethernet”.
Для дальнейшей информации по установке программного пакета NCM S7 для Industrial
Ethernet продукте обращайтесь, пожалуйста, к прилагаемой информации о продукте или файлу
readme.

Замечание
Пожалуйста, обратите внимание, что файл readme для NCM S7 для Industrial Ethernet может
содержать дополнительную информацию о примере программ, описанных в этом примере.

Соглашения

В примере использованы следующие соглашения:
• Ссылки на другие руководства и документацию обозначены
номером, заключенным слешами /.../. Эти номера ссылаются на
название руководств, перечисленных в приложении.

• Действия, которые Вам необходимо выполнить обозначены
символом ”ν”



Обзор шагов

Основываясь на примере конфигурации и примере программ “PROJECT ETHERNET” мы
проведем Вас через следующие шаги в следующих разделах:

Лучше создавать все системные
данные «offline». Тогда данные
м.б. потом изменены,
сохранены и загружены в любое
время. Основа для этого проект
STEP 7.

1. Создание/открытие Вашего проекта

2. Конфигурирование и подключение к сети Вашей апаратуры

3. Конфигурирование коммуникационных служб

4. Написание программы пользователя

Вы задаете компоненты систем.
На основе списка в Разделах 3, 4.

Вы устанавливаете
транспортные соединения
ISO

Вы преобразуете Вашу задачу
управления в программу
пользователя S7. Вы,
например, можете
использовать представление
STL

5. Запуск/диагностика
При возникновении проблем,
Вы можете исследовать
станцию S7 с помощью online
инструментов STEP 7/STL и
диагностики NCM.

Раздел 2
“PROJECT ETHERNET "

Раздел 3
ISO     S7<->S7

Раздел 4
ISO     S7<->S5

1
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Для того, чтобы быстрее достигнуть цели...
Если конфигурация Вашей системы соответствует конфигурации примера, Вы можете сразу
загрузить данные примера в станции S7 в шагах 2, 3 и 4!
Однако, Вы узнаете больше, проделав все шаги,
показанные в этом примере.

СОВЕТ
Пропустите функции, которые
Вы уже знаете.



“PROJECT ETHERNET”
Примеры STEP 7 для Ethernet CP

Этот раздел объясняет, как Вы можете использовать
“PROJECT ETHERNET” с конфигурациями и
программами для коммуникационных примеров.

Как раздел поможет Вам:

• Вы узнаете, как создать проект с CP
• Вы узнаете все шаги, вовлеченные в
конфигурирование

Требования:
Базовые знания STEP 7, опыт работы с STL, базовые
знания ПЛК.

Если Вам потребуется более подробная информация о
других функциях программного пакета
конфигурирования, обращайтесь, пожалуйста, к
соответствующим руководствам. Этот раздел также
содержит ссылки на соответствующие руководства.

Содержание:

- Создание/открытие Вашего проекта 2-2
- Конфигурирование Вашей аппаратуры и
подключение ее к сети 2-5

2
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1. Создание/открытие Вашего проекта

2. Конфигурирование и подключение к сети аппаратуры

Программа пользователя и
объекты станций S7 управляются
в проекте STEP 7.

После установки дополнительного программного пакета NCM S7, пример проекта находится в
каталоге проектов STEP 7, например, в каталоге C:\SIEMENS\STEP7\EXAMPLES\EXIE.

Если Вы хотите использовать проект из каталога S7, следуйте шагам,
показанным ниже:
✔ Запустите SIMATIC Manager.
✔ Откройте поставляемый пример проекта PROJECT ETHERNET с помощью File > Open >

Project... (Файл > Открыть > Проект…).

Из примера программы,
показанной здесь, Вы
переходите к шагам,
описанным в
следующих разделах

Пример проекта содержит подсеть Ethernet. Если Вы хотите
создать новую подсеть Ethernet или другой объект,

✔ Выберите функцию Insert > … > … (Вставить > …
> …). Руководство

/3/

Раздел 2

Более подробная
информация
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Если Вы хотите создать рабочую версию примера проекта Ethernet...
✔ ...Используйте функцию File > Save As (Файл > Сохранить как), чтобы создать копию
примера проекта в любом каталоге, котором Вы хотите.

Следующая таблица показывает конфигурации каждой станции. Она показывает так же, какую
часть примера Вы можете использовать напрямую или адаптировать, по Вашему желанию.

Станция Тип CP Адрес MAC Связывается
со станцией

Описание

SIMATIC 400
station(1)

CP 443–1 08.00.06.01.00.00 SIMATIC 400
station(2)

SIMATIC 400
station(2)

CP 443–1 08.00.06.01.00.01 SIMATIC 400
station(1)

Обмен данными по SEND/RECEIVE
интерфейсу с CP 443-1.
Данные передаются в обоих
направлениях. Используются FC:
AG_SEND и AG_RECV.

SIMATIC 400
station(3)

CP 443–1 08.00.06.01.00.03 S5 station(1)

SIMATIC
S5(1)

CP 1430 TF 08.00.06.01.00.02 SIMATIC 400
station(3)

Обмен данными по SEND/RECEIVE
интерфейсу с CP 443-1.
Программа пользователя адаптирована
к примеру программы для CP 1430 TF
(см. /14/).
Данные передаются из SIMATIC 400
station(3) в станцию SIMATIC S5.
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Вы уже создали конфигурацию
Если Вы уже создали конфигурацию и просто хотите использовать пример программы для
Вашего CPU, следуйте шагам описанным ниже:
✔ Скопируйте пример программы (контейнер с программами S7) для станции из примера
проекта в CPU уже существующего Вашего проекта. Убедитесь, что блоки не совпадают.

✔ Убедитесь, что аппаратная конфигурация, подключение к сети и сконфигурированные
соединения адаптированы согласно описаниям ниже.

Резюме шага 1 “Создание проекта”:
Вы создали проект STEP 7,
- в котором Вы можете сконфигурировать Вашу систему
- и в котором Вы можете создать и сохранить Ваши программы пользователя.
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1 Создание/открытие Вашего проекта

2. Конфигурирование и подключение
 к сети аппаратуры

•  Из каких компонент состоит система?
•  Как компоненты подсоединены к

сети?
Когда закончите, Вы загрузите
аппаратную конфигурацию в станции.

�

Если Вы начали с существующего примера
конфигурации, то перед тем как Вы загрузите
конфигурацию в ПЛК, Вы должны получить общую
картину. STEP 7 предлагает комфортабельные методы.
Вы можете выполнить следующее:
• Отобразить конфигурацию в конфигурировании аппаратуры
• Отобразить обзор станции
• Отобразить графическое подключение станций к
сети с NETPRO

� В SIMATIC Manager в Вашем проекте щелкните дважды по объекту “Ethernet(1)”.
Откроется представление NETPRO для Вашего проекта.

Из этого экрана, Вы можете выполнить все шаги, требуемые для конфигурирования
аппаратуры и соединений.
Как показано на рисунке:
• В нижней части экрана отображается таблица соединений для выбранного CPU.
• Информация о присоединении к сети отображается, если Вы поместите указатель мыши на
значок интерфейса узла.

СОВЕТ
На стр. 2-10 рассматривается
тема “Загрузка”

Руководство
/3/

Раздел 2

Более подробная
информация



2-6     SIMATIC NET NCM S7 для Industrial Ethernet

Вы можете увидеть следующее:
CP 443–1 показан с MAC адресом и адресом MPI. Адрес MPI необходим Вам, когда Вы,
например, хотите получить диагностическую информацию о CP через MPI соединение с CPU,
используя диагностику NCM Industrial Ethernet.

Если Вы хотите изменить сетевой адрес...
... Вы можете вызвать диалог свойств узла Ethernet. Вы
вызываете этот диалог дважды щелкнув по узлу сети в
представлении NETPRO. Изменение адреса м.б.,
например, необходимо, когда заданный адрес Ethernet
уже используется в Вашей сети другой станцией.

Отображение конфигурации в конфигурировании аппаратуры на примере
SIMATIC 400 station(1)
✔ Выберите SIMATIC 400 station(1) в представлении NETPRO; затем выберите Edit > Open

Object (Правка > Открыть объект). Вы увидите аппаратную конфигурацию.

Если Вы хотите посмотреть конфигурацию одного из отображаемых модулей более детально,
✔ Поместите курсор на модуль, например, CP 443-1 и выберите Edit > Object Properties

(Правка > Свойства объекта).

Руководство
/3/

Раздел 2.2.4

Более подробная
информация
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Адаптирование конфигурации в конфигурировании аппаратуры
Если Ваша аппаратная конфигурация не соответствует конфигурации примера, Вы можете ее
изменить. Например, Вы можете выполнить следующие изменения:
• Переместить модули в другие посадочные места.

- Конфигурация соединений сохраняется.
- Программы пользователя д.б. адаптированы для новых адресов модулей.

• Работа без модуля симулятора
Для этого удалите модуль симулятора из 4 посадочного места.

• Использование другого типа CP

Распечатка обзора станции
Используйте функции печати STEP 7, чтобы создать документацию по Вашей системе. Из
аппаратной конфигурации Вы можете распечатать следующую документацию для:
• Всей станции
• Выбранного модуля
Распечатка для выбранного Вами модуля CP будет выглядеть, как показано ниже (пример):
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Дальнейшая информация о подключении станций к сети
Вы можете получить обзор существующих сконфигурированных присоединений к сети,
используя функцию печати в NETPRO.
Распечатка для сконфигурированных сетей будет выглядеть, как показано на примере ниже:
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Для того, чтобы загрузить аппаратную конфигурация в ПЛК...
...следуйте шагам показанным ниже:
✔ Подсоедините PG к MPI интерфейсу CPU, используя кабель MPI.
✔ Установите интерфейс на Вашем PG/PC для требуемого типа соединения.
✔ В панели управления Windows выберите PG/PC интерфейс и задайте параметры, чтобы они
соответствовали CP, установленному в Вашем PG, и подключению к шине.

✔ Переведите CPU в режим STOP,
независимо от типа соединения - см. выше

✔  Выберите пункт меню PLC > Download (ПЛК > Загрузка).
STEP 7 проведет Вас через диалоговые окна к требуемому результату.

Резюме шага 2 “Конфигурирование и подключение к сети
Вашей аппаратуры”:
Теперь Вы выполнили следующее
1. Сконфигурировали станции S7 в проекте STEP 7
2. Назначили станции S7 к подсети Ethernet и задали им адреса
3. Загрузили конфигурацию в обе станции S7.
Теперь станции готовы для того, чтобы Вы сконфигурировали коммуникационные
соединения и загрузили программы пользователя.

STEP 7 Help System

Более подробная
информация

Руководство
/3/

Раздел 2.2.9

СОВЕТ
Чтобы проверить, какие узлы доступны по MPI,
используйте функцию “Acctssible Nodes”
(«Доступные узлы»)
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Связь по интерфейсу SEND/RECEIVE
между станциями S7

Интерфейс SEND/RECEIVE предоставляет обмен
данными по сконфигурированным транспортным
соединениям ISO.
Этот раздел объясняет шаги, необходимые во время
конфигурирования и программирования для
реализации простейших коммуникационных задач по
транспортным соединениям ISO.

Как раздел поможет Вам:

• Вы узнаете шаги, вовлеченные в
конфигурирование.

• Вы научитесь загружать и запускать.
• Вы познакомитесь с вызовами интерфейса

SEND/RECEIVE.
• Вы сможете использовать пример программы в
качестве шаблона для создания программы ПЛК.

Требования:
Базовые знания STEP 7, опыт работы с STL, базовые
знания ПЛК.

Если Вам необходима более подробная информация о
свойствах различных типов коммуникаций,
представленных здесь, или о других функциях
обеспечиваемых программным пакетом
конфигурирования, обращайтесь, пожалуйста, к
соответствующему руководству. Введение в
руководства предоставляет Вам обзор доступной
документации. Этот раздел также содержит ссылки на
соответствующие руководства.

Содержание:
3.1 Задача 3–2
3.2 Конфигурация системы 3–3
3.3 Пример шаг–за–шагом 3–5

- Конфигурирование транспортных
 соединений ISO 3–6

- Создание программы пользователя 3–11
- Запуск/диагностика 3–17

3
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3.1  Задача

Передача и прием данных
Коммуникационная задача, проиллюстрированная примером программы, была специально
задумана простой.
• Контроллер (SIMATIC 400 Station 1) обрабатывает данные процесса.
• Он связывается с другим устройством (SIMATIC 400 Station 2), например, чтобы передать
управляющее задание. SIMATIC 400 Station 2 возвращает ответные данные в станцию 1.

Следующая схема показывает, как работает программа:

SIMATIC 400
Station(1)

Передача данных
задания (4 байта)

Обработка данных
процесса

Анализ принятых
данных

Время Время

Прием и обработка
задания

SIMATIC 400
Station(2)

Передача ответных
данных (4 байта)

В примере задачи передаваемые данные задания и ответа имеют длину 4 байта.
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3.2 Конфигурация системы

Структура
Для поставляемого примера проекта требуется следующая конфигурация системы (возможны
изменения/альтернативы - > см. следующую страницу):

SIMATIC 400 станция 1

Ethernet

PG/PC с STEP 7

Интерфейс MPI

SIMATIC 400 станция 2

as

Интерфейс MPI
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Требуемые устройства/ресурсы
Вам потребуются следующие компоненты, если Вы захотите использовать пример не изменяя
его.

Кол-во Тип Номер для заказа:
2 Программируемый контроллер S7–400 с CPU 414-1 См. каталог ST 70
2 CP 443–1 6GK7 443–1AX00–0XE0
2 Модуль симуляции DI/DO

М.б. заменен на
Модуль цифровых выходов DO16xDC24V/2A
или на
Модуль цифровых выходов DO16xDC24V/0,5A

6ES7 422–1BH10–0AA0

6ES7 422–1BL10–0AA0
1 Среда передачи См. /11/ /12/
1 Устройство программирования (PG/PC) с

• установленным программным пакетом STEP 7 версии
V3.x или выше

• дополнительным программным пакетом NCM S7 для
Industrial Ethernet версии V3.x или выше.

• Интерфейс MPI
• Как опция для работы PG/PC на Ethernet: CP для

подключения к Ethernet ->
диагностика/запуск/обслуживание

См. каталог ST 70

Альтернативы:
Вы можете адаптировать пример конфигурации для Вашей собственной конфигурации.
Возможные изменения включают следующее:
• Использование S7–300 вместо S7–400
Вместо станции S7–400 Вы также можете использовать станцию S7–300. В этом случае Вы
должны использовать, например, CP 343–1.
Соответствующие изменения должны быть выполнены при конфигурировании
аппаратуры.

• Использование другого типа CPU
• Работа без модулей симуляции
Это требует только небольших изменений в программах пользователя, что уже не
существует вывода на модуль симуляции. Остается возможность наблюдать связь,
отображая блоки данных на PG.

• Использование других модулей ввода/вывода
Это может означать, что изменится адресация модулей.

• Изменение порядка модулей в носителе модулей
С некоторыми типами CPU это приведет к изменению адресов модулей.

Замечание
Если Вы измените адрес модуля в конфигурации, Вы должны также адаптировать программу
пользователя и сконфигурированные соединения.
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3.3  Пример шаг–за–шагом

Это описание основывается на созданном проекте и на сконфигурированных станциях. Шаги
“Создание проекта” и “Конфигурирование и подключение к сети аппаратуры” были
объяснены в 2 Разделе.

1. Создание/открытие Вашего проекта

2. Конфигурирование и подключение к сети аппаратуры

3. Конфигурирование соединений ISO

4. Написание программы пользователя

5. Запуск - Диагностика

�
�

Для того, чтобы быстро достигнуть цели...
Если конфигурация Вашей системы соответствует конфигурации примера, Вы можете сразу
загрузить данные примера в станции S7 в шагах 3 и 4!

Однако, Вы узнаете больше, проделав все шаги,
показанные в этом примере.

СОВЕТ
Пропустите функции,
которые Вы уже знаете.
В Разделе 2 рассматривается
тема “Загрузка”
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1. Создание/открытие Вашего проекта
2. Конфигурирование и подключение к сети аппаратуры

3. Конфигурирование соединений ISO

4. Написание программы пользователя

5. Запуск - Диагностика

Какие CPU используют
коммуникационные соединения
для каких задач коммуникации.
Когда закончите, Вы загрузите
конфигурацию соединений в
станции.

�
�

Связь по интерфейсу SEND/RECEIVE используя
сконфигурированные соединения ISO. В следующем
шаге Вы должны загрузить список соединений в
станции.
Однако, вначале Вы должны получить общее представление о примере конфигурации как
показано:

• Проверьте сконфигурированные соединения в таблице
соединений.

Проверка соединений в таблице соединений
✔ Перейдите назад в SIMATIC Manager и выберите в CPU соответствующей станции.

Руководство
/3/

Раздел 3

Более подробная
информация

СОВЕТ
Стр. 3-11 содержит более подробную
информацию по теме “Загрузка”
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✔ Выберите объект «Connection» (“Соединение”) и
затем выберите Edit > Open Object (Правка >
Открыть объект). Отобразится таблица
соединений.

или
✔  Перейдите в представление NETPRO, выбрав сеть.

Здесь, дважды щелкнув,
Вы можете выбрать
свойства соединения

Здесь Вы можете выбрать “Change
Partners” (“Изменить партнера”)

Вы увидите следующую картину:
Сконфигурировано одно транспортное соединение ISO
со станцией партнером SIMATIC 400 Station(2).
Установление соединения активировано SIMATIC 400
Station(1).

Другие соединения...
... В этом представлении Вы можете сконфигурировать другие соединения с этой или другой
станцией партнером.
✔ Для того, чтобы добавить новое соединение в список соединений, выберите функцию

Insert > Connection (Вставить > Соединение).

Connection

Замечание...
Выбрав станции, Вы можете
получить обзор всех станций в
проекте и сконфигурированных
соединений
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Если необходимо, Вы можете проверить другие параметры соединения, как
показано...
✔ Выберите свойства соединения, дважды щелкнув по соединению в таблице соединений.

0001 – идентификатор ID,
который Вы используете в
программе пользователя при
вызовах  интерфейса
SEND/RECEIVE.
A020 – идентификатор ID для
транспортных соединений ISO

Замечание о параметрах блока:
Стартовый адрес модуля и ID
соединения потребуются позже, когда
Вы будете программировать
интерфейс SEND/RECEIVE.

Вы можете назначить имя
соединения, соответствующуе
использованию в Вашей системе

Вкладка “Addresses” («Адреса»).
Значения во вкладке “Addresses” («Адреса») для соединений между станциями S7 в одном
проекте обычно не требуется изменять.
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Вы можете получить дополнительную информацию о состоянии соединения
или конфигурации соединения во вкладке ”Overview” (“Обзор”).

Help
Cancel Cancel Help

Если в поле “Local ID” («Локальный идентификатор») стоит“!”, то в поле “Status”
(«Состояние») отображается соответствующая дополнительная информация. В зависимости от
установок заголовка таблицы, этот поле м.б. скрыто. Используя клавиши управления
курсором, Вы можете перемещаться по таблице горизонтально.
В показанном случае показано завершенное соединение.

Если Вы хотите адресовать другого партнера по связи...
✔ ...выберите диалог “Change Partners” («Изменение партнера») из пункта меню Edit >

Change Partners (Правка > Изменение партнера) или дважды щелкните по соединению в
таблице соединений в колонке “Partner” («Партнер»).

✔ Если необходимо, выберите другого партнера по соединению в поле “Station” «Станция».
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Для того, чтобы загрузить конфигурацию соединений в ПЛК...
...следуйте шагам показанным ниже:
✔ Если Вы произвели изменения в конфигурации соединений, сохраните Ваши изменения
при помощи Connection Table > Save (Таблица Соединений > Сохранить).

✔ Выберите станцию в таблице соединений, для которой существует подключение MPI.
✔ Выберите функции PLC > Download (ПЛК >Загрузка) .

✔  Закройте таблицу соединений.

✔ Подключите MPI ко второй станции.
✔ Повторите шаг 2 “Конфигурирование/Подключение к сети Вашей аппаратуры” и шаг 3

“Конфигурирование транспортного соединения ISO ” для второй станции.

Резюме шага 3 “Конфигурирование транспортного соединения ISO”:
Вы выполнили следующее:
1. Сконфигурировали транспортное соединение ISO между двумя станциями S7
2. Загрузили конфигурацию соединения в две станции S7
Станции теперь готовы для обмена данными по интерфейсу SEND/RECEIVE.

Замечание:
Во время загрузки у Вас спросят,
хотите ли Вы скопировать
RAM в ROM.
Если Вы хотите защитить
Ваши данные при отказе
питания, ответьте “Yes” («Да»).

STEP 7 Help System

Более подробная
информация

Руководство
/4/
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1. Создание/открытие Вашего проекта
2. Конфигурирование и подключение к сети аппаратуры

3. Конфигурирование соединений ISO

4. Написание программы пользователя

5. Запуск - Диагностика

- Как обеспечивается данными
SEND/RECEIVE интерфейс?

- Как обрабатываются биты
состояния?

Когда закончите, Вы загрузите
программы пользователя в
станции.

�
�

�

Задачи в программе пользователя
Задача, описанная в Разделе 3.1, должна быть теперь преобразована в соответствующую
программу программируемого логического контроллера.

Чтобы исполнить программы или чтобы загрузить их в станции S7...

✔  ...выберите контейнер с программными блоками в
соответствующей станции SIMATIC 400 в PROJECT–
ETHERNET.

Функции блоков
объясняются в
следующей таблице

Для лучшего обзора...
✔ ...Вы должны распечатать программные блоки и просмотреть их. Следующая страница
содержит обзор FC, необходимых для коммуникации.

СОВЕТ
Стр. 3-17 содержит более подробную
информацию по теме “Загрузка”
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Таблица показывает, какие программные блоки типа OB и FC выполняют какие задачи.

Задача в S7 Station 1 Задача в S7 Station 2 Описание задачи в программных блоках
Обработка данных
процесса

Симуляция изменения значений процесса:
OB100
Подготавливает блоки данных DB30 и DB31. Процессные
значения сохраняются в этих блоках данных.
OB1
Координирует работу программы.
FC29
Слово данных циклически инкрементируется и
декрементируется. Временной интервал для
инкрементирования и декрементирования равен 10
секундам.
FC30 / FC5 (AG_SEND)
Передает слово данных в Станцию 2, как текущее значение
процесса (задание).

Прием и обработка
задания

Прием и дальнейшая обработка данных задания:
OB100
Подготавливает блоки данных DB30 и DB31. Процессные
значения сохраняются в этих блоках данных.
OB1
Координирует работу программы.
FC31 / FC6 (AG_RECV)
Сохранение принятых данных в блоке данных и вывод
данных на симуляцию процесса.
FC30 / FC5 (AG_SEND)
Возвращает данные в Станцию 1 как подтверждение
задания.

Анализ принятых
данных

FC31 / FC6 (AG_RECV)
Прием и анализ подтверждения задания.
Вывод данных процесса на модуль симуляции.
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Последовательность программы
Организационные блоки в примере выполняют следующую программную последовательность
в двух станциях S7:

AG_SEND

OB1

Обозначение Последовательность цикла CPU

AG_RECV

ISO
соединение

FC30

FC31

FC29

OB100

- Инкрементирование
/ декрементирование
слова данных

Запуск

Циклическое
выполнение

   Генерация
блоков данных
DB30 и DB31

AG_RECV

FC31

AG_SEND

FC30

OB1

OB100

SIMATIC 400 Station(1) SIMATIC 400 Station(2)

   Генерация
блоков данных
DB30 и DB31
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Программирование функций (FC) для обмена данными
Для управления коммуникациями по транспортным соединениям ISO существуют две
функции (FC), как показано:
• AG_SEND (FC5)
Этот блок передает данные пользователя из
заданной области данных пользователя в Ethernet
CP для передачи.

• AG_RECV (FC6)
Этот блок заносит принятые данные пользователя в
область данных пользователя, заданную при
вызове.

В нашем примере программа пользователя написана в представлении STL. Ниже, в качестве
примера, показано назначение параметров для вызовов AG_SEND и AG_RECV в SIMATIC
400 Station(1) (клиент).

STL Комментарий
call fc 5
ACT := M 50.0
ID := 1
LADDR := W#16#0110
SEND := P#db30.dbx1.0 byte 240,
LEN := 4
DONE := M 1.2
ERROR := M 1.3
STATUS := MW 200

// Вызов блока AG_SEND
// Бит для запуска задания
// ID соединения
// =LADDR 272Dec. в аппаратной конфигурации
// Область данных для передачи
// Длина области данных для передачи (4 байта)
// Бит флагов для возвращаемого параметра DONE
// Бит флагов для возвращаемого параметра ERROR
// Слово флагов для возвращаемого параметра STATUS

STL Комментарий
call fc 6

ID := 1
LADDR := W#16#0110
RECV := P#DB31.DBX 1.0 BYTE 240
NDR := M1.0
ERROR := M1.1
STATUS := MW202
LEN := MW10

// Вызов блока AG_RECV
//
// ID cоединения
// Адрес модуля 272Dec. в аппаратной конфигурации
// Область данных для приема данных
// Бит флагов для возвращаемого параметра NDR
// Бит флагов для возвращаемого параметра ERROR
// Слово флагов для возвращаемого параметра STATUS
// Длина принятых данных

Для полного листинга, содержащегося в этих FC и других OB и FC, обращайтесь, пожалуйста,
к распечатке примера проекта.

FC AG_LSEND / AG_LRECV для больших объемов данных

Новые версии Ethernet CP могут передавать большие объемы данных (до 8192 байт) с FC
AG_SEND (FC50) AG_RECV. Обращайтесь, пожалуйста, к информации о продукте для
Вашего CP для поддерживаемой области данных, и если соответствует, то используйте
соответствующие FC.

Руководство
/3/

Раздел 4

Более подробная
информация

Руководство
/3/

Раздел 5

Более подробная
информация



SIMATIC NET NCM S7 для Industrial Ethernet 3-15

Расширение примера программы
Вы также можете расширить пример программы или позже Ваше собственное приложение,
включив дополнительные функции, такие как следующие:
• Анализ результатов кодов FC AG_SEND и AG_RECV, что позволит Вам реагировать на
особые состояния или ошибки.

• Условная инициализация коммуникационных вызовов, зависящая от результатов кодов,
например, вызов на передачу запускается на клиенте снова только после приема
подтверждения задания с вызовом на прием.

✔  Анализ параметров DONE, ERROR и STATUS для
AG_SEND и NDR, ERROR и STATUS для
AG_RECV. Вы анализируете эти параметры как
показано ниже:

Задание

Завершено без ошибок Выполняется Завершено с ошибкой

Типичные коды ошибок (STATUS), которые
д.б. обработаны в программе пользователя:

8302H Нехватка ресурсов у партнера
8311H Станция назначения недоступна
(например, из-за запуска)
80C3H Ресурсы заняты
(из-за максимальной загрузки S7-400)
80D2H Неверный стартовый адрес модуля
(например, Вы забыли изменить адрес после
перемещения модуля)
8304H Соединение еще не установлено

DONE/NDR = 1
ERROR = 0
STATUS = 0

DONE/NDR = 0
ERROR = 0
STATUS = 8180/8181

DONE/NDR = 0
ERROR = 1
STATUS = x

Пример без модуля симулятора
Если Вы не хотите использовать модуль симулятора, просто деактивируйте выход “T QW ...” в
блоке FC31 в SIMATIC 400 Station 1 и 2.
Вы можете следить за выполнением программы, отображая блоки данных online в STEP 7 /
STL.

Руководство
/3/

Раздел 4.2

Более подробная
информация
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Для того, чтобы загрузить программу пользователя в ПЛК...
...следуйте шагам, показанным ниже:
✔ Переведите CPU в STOP или RUN–P.
✔ В SIMATIC Manager в соответствующей станции выберите контейнер “Blocks” («Блоки»).
✔ Загрузите всю программу (кроме STB) используя функцию PLC > Download (ПЛК >
Загрузка).

✔ Переведите CPU в RUN–P или RUN.

✔ Повторите процедуру загрузки для других станций.

Резюме шага 4 “Создание программы пользователя”:
Вы выполнили следующее:
1. Создали программу пользователя согласно описанию задачи для обеих станций S7
2. Расширили пример программы, например для анализа кодов состояний
3. Загрузили программы пользователя в CPU для обеих станций S7
Результат:
Если Вы работаете с модулем симулятора, Вы должны теперь увидеть горящие светодиоды
на модулях симуляторах.

Если Вы не можете обнаружить передачу данных, выполните следующее:
✔ Проверьте последовательность программы online в STEP 7/STL. Проверьте, выдается ли
изменяемое слово данных на модуль симуляции.

✔  Перейдите к следующему шагу и проверьте связь при помощи диагностики NCM Ethernet.

Замечание:
В режиме RUN-P надо обращать
внимание на последовательность
блоков, т.к. цикл CPU активен.
Удостовертесь, что OB100
выполняется только при запуске.

STEP 7 Help System

Более подробная
информация

Руководство
/4/
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1. Создание/открытие Вашего проекта

2. Конфигурирование и подключение к сети аппаратуры

3. Конфигурирование соединений ISO

4. Написание программы пользователя

5. Запуск - Диагностика

Используя диагностику Ethernet
Вы можете распознать
коммуникационные проблемы.

�

�

�
�

✔ Используя, например, следующие функции
диагностики, проверьте состояние станции и
транспортных соединений ISO.

NCM S7 H1 Diagnostics

ISO

Total Configuration
Free Configuration
RAM in

Status of the

Status

Memory

CP Operating Diagnostic Option

Operating Mode:      Run

S7
ISO

Run Cause:
Cause

OK

1024

 251
    10

Transfer

Run OK

Conn. Conn. Remote MAC Se Receiv

ISO

1   Connection-1   080006010002   40772

Connection is
Waiting to receive
Data transfer on
ISO-1
ISO-2

Connection

Каков статус
станций?

Что говорят
записи в
диагностическом
буфере?

Каково состояние
транспортных
соединений ISO?

Были переданы кадры?
Сколько успешно?
Сколько с ошибкой?

Connection
Receive
Send
Local TSAP
Remote TSAP

>

4

Diagnostic

No.              Time Stamp                     Function
8   01.01.96 01:39:19   SEND/REC...      ISO transport connection
3   01.01.96 01:39:19   SEND/REC...      ISO transport connection
2   01.01.96 01:39:19   SEND/REC...      ISO transport connection

Decoded Event

ISO transport connection 1 is not

Руководство
/3/

Раздел 5

Более подробная
информация
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Связь по интерфейсу SEND/RECEIVE
между станциями S7 и S5

В первом примере мы показали Вам шаги,
вовлеченные в конфигурирование и программирование
для реализации простой задачи коммуникации по
транспортным соединениям ISO.
В этом разделе, мы покажем Вам (небольшие) отличия,
которые появляются, если Вы хотите обмениваться
данными со станциями “не–S7”. Эти станции обычно
называют “Other Stations” (“Другие станции”).

Задача коммуникации в этом разделе остается такой
же, как в первом примере. Изменяется только
конфигурация системы - станция S7 заменена на
станцию S5.
Основываясь на Разделе 1, Вы дополнительно научитесь
следующему:

• Как работать с SIMATIC S5 или “Станциями не–S7”
в проекте STEP 7

• Как проектировать транспортные соединения ISO со
“Станциями не–S7”

Требование:
Базовые знания STEP 7, знание STL, базовые знания
ПЛК, знание SIMATIC S5.

Содержание:
4.1 Изменение конфигурации системы 4-2
4.2  Пример шаг–за–шагом 4-4

- Создание Вашего проекта 4-5
- Конфигурирование/подключение
к сети Вашей аппаратуры 4-6
- Конфигурирование транспортного
соединения ISO 4-9
- Создание программы пользователя 4-12

4
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4.1 Конфигурация системы

В конфигурации системы, показанной в Разделе 3.2, S7 станция 2 заменена на станцию
SIMATIC S5 (возможны изменения/альтернативы -> см. Раздел 3.2):

Ethernet

PG/PC с STEP 7 и STEP 5

Интерфейс MPI

as

SIMATIC S5
с CP 1430 TF

SIMATIC  400 станция (1)

Интерфейс AS511
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Необходимые устройства/ресурсы
Вам необходимы следующие компоненты, если Вы хотите использовать поставляемый пример
без изменений.

№ Тип Номер для заказа
1 Программируемый контроллер SIMATIC S7–400 См. каталог ST 70
1 CP 443–1 6GK7 443-1BX00-0XE0
1 Программируемый контроллер SIMATIC S5 См. каталог ST 52.3, ST 54.1
1 CP 1430 TF 6GK1 430-0TA0x

6GK1 430-0TB0x
1 Среда передачи См. /7/, /11/, /12/
1 Устройство программирования (PG/PC) с

• установленным программным пакетом STEP 7 версии
V3.x и STEP 5 V6.x или выше

• дополнительным программным пакетом NCM S7 для
Ethernet версии V3.x или выше.

• установленным программным пакетом и NCM COM
1430 TF

• Интерфейс MPI
• Как опция для работы PG/PC на Ethernet: CP для

подключения к Ethernet ->
диагностика/запуск/обслуживание

Для станции S5 Вы можете использовать пример программы,
поставляемый вместе с пакетом конфигурирования NCM
COM 1430. В зависимости от аппаратной конфигурации
(типа CPU и т.д.), Вы должны выбрать соответствующий
пример программы.

Руководство
/14/
Том 1
Раздел 7
Прилож A.4

Более подробная
информация
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4.2  Пример шаг–за–шагом

Следующий пример основан на созданном проекте и сконфигурированной станции. Шаги
“Создание Вашего проекта” и “Конфигурирование/подключение к сети Вашей аппаратуры”
были объяснены в Разделе 2.

1. Создание/открытие Вашего проекта

2. Конфигурирование и подключение к сети аппаратуры

3. Конфигурирование соединений ISO

4. Написание программы пользователя

5. Запуск - Диагностика

�
� Раздел 2

Раздел 4.2 / и последующие
страницы

Для того, чтобы быстро достигнуть цели...
Если конфигурация Вашей системы соответствует конфигурации примера, Вы можете сразу
загрузить данные примера в станцию S7 в шагах 3 и 4!

Однако, Вы узнаете больше, проделав все шаги,
показанные в этом примере.

СОВЕТ
Пропустите функции,
которые Вы уже знаете.
В Разделе 2 рассматривается
тема “Загрузка”
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1. Создание/открытие Вашего проекта
2. Конфигурирование и подключение к сети аппаратуры

3. Конфигурирование соединений ISO

4. Написание программы пользователя

5. Запуск - Диагностика

Дополнительно:
Станция S5 управляется с
NCM COM 1430 TF.

Конфигурирование станции 2 (S5):
Для редактирования программ и файла базы данных для примера программы для CP 1430 TF,
используйте пакет STEP 5 V6.x и NCM COM 1430 TF.

NCM COM 1430 TF

Database file: ABU1AG2.CP2

Среда конфигурирования для
SIMATIC S5 с CP 1430 TF

Руководство
/11/
Том 1
Раздел 7
Прилож A.4

Более подробная
информация

Резюме шага 1 ”Создание Вашего проекта”:
1. Вы создали проект в STEP 7, в котором Вы можете сконфигурировать Вашу станцию S7
и сохранить соответствующие программы пользователя.

2. Вы создали файл базы данных для станция S5, в котором м.б. сохранены данные
конфигурации CP.
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1. Создание/открытие Вашего проекта

2. Конфигурирование и подключение к сети аппаратуры

3. Конфигурирование соединений ISO

4. Написание программы пользователя

5. Запуск - Диагностика

Дополнительно:
- Станция S5 д.б. включена в

проект STEP 7 и подключена к
сети.

- Адреса Ethernet и параметры
сети для ПЛК S5 и S7 должны
соответствовать друг другу.

�

Для того, чтобы сконфигурировать станцию S7 в проекте STEP 7...
...следуйте процедуре, описанной в Разделе 2.

Управление станцией S5:
За информацией об управлении конфигурационными данными и
(примерами) программ обращайтесь, пожалуйста, к:
Там Вы найдете информацию о работе с инструментарием S5.

Чтобы связать станцию S7 со станцией S5
и иметь возможность адресовать станцию по транспортному соединению ISO...
...эта “станция S5” д.б. включена в проект STEP 7. В примере проекта была создана станция
типа “SIMATIC S5”.

s5_h1 S7-400_1

S5

MPI Network(1)

S7 Program(1)

s5_h1 <Offline> [Project] - SIMATIC Manager

File Edit Insert PLC View Options Window Help

SINEC H1 Network

Если Вы хотите продолжить работать в другом проекте, Вы должны теперь создать “станцию
SIMATIC S5”.
✔ Выберите Ваш проект.
✔ Выберите функцию Insert > Station > SIMATIC S5 (Вставить > Станция > SIMATIC S5).

Руководство
/14/
Том 1
Раздел 5
Прилож A.4

Более подробная
информация
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...Теперь подключение станции к сети
Подключение станции S7 к сети производится так же, как и в первом примере. Интереснее,
как подключается к сети станция SIMATIC S5.
✔ Выберите в Вашем проекте станцию S5, используя

SIMATIC Manager или представление NETPRO.
✔ Выберите диалог Object Properties (Свойства объекта) с помощью пункта меню Edit >

Object Properties (Правка > Свойства объекта) или дважды щелкнув по кнопке в панели
инструментов.

✔ Перейдите во вкладку «Nodes» (“Узлы”).

HelCanc
l

       Чтобы проверить,
какой адрес MAC
используется для S5,
выберите узел Ethernet
и щелкните по кнопке
“Properties”
(“Свойства”)

✔✔✔✔
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Загрузка аппаратной конфигурации в ПЛК

Для того, чтобы загрузить данные конфигурации в станцию S7
следуйте шагам, показанным ниже
• Для станции S7, как описано в Разделе 2.
• Для станции S5, как описано в

Резюме шага 2 ”Конфигурирование и подключение к сети Вашей аппаратуры”:
Вы выполнили следующее:
1. Сконфигурировали станцию S7 в проекте STEP 7
2. Присоединили станцию S7 к подсети Ethernet и назначили адреса
3. Загрузили конфигурацию в станцию S7
4. Адаптировали конфигурацию сети станции S5 с NCM COM 1430
Станция S7 теперь готова для конфигурирования коммуникационных соединений и
загрузки программы пользователя.

Руководство
/14/

Раздел 6

Более подробная
информация
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1. Создание/открытие Вашего проекта

2. Конфигурирование и подключение к сети аппаратуры

3. Конфигурирование соединений ISO

4. Написание программы пользователя

5. Запуск - Диагностика

Дополнительно:
Параметры соединения для
ПЛК S5 и S7 должны
соответствовать друг другу.

�
�

Для того, чтобы создать транспортные соединения ISO для станции 1 (S7) в
проекте STEP 7...
...следуйте шагам, описанным в первом примере:
• Отобразите сконфигурированные соединения в таблице соединений
• Загрузите сконфигурированные соединения в ПЛК

Проверка/конфигурирование параметров соединения
Во вкладке Addresses (Адреса) адаптируйте параметры TSAP, чтобы они соответствовали
конфигурации в Станции 2 (S5). Только тогда локальные конечные точки соединение могут
быть правильно идентифицированы и соединение м.б. успешно установлено.
✔ Откройте таблицу соединений для CPU в станции S7
✔ Выберите свойства соединения, дважды щелкнув по соединению в таблице соединений.

✔ Проверьте параметр “Active Connection Estyablishment” (“Активное установление
соединения”). Он д.б. выбран.
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✔ Перейдите во вкладку “Addresses” («Адреса»).
✔  Проверьте значения TSAP и, если необходимо, адаптируйте их, чтобы они соответствовали

конфигурации станции S5.

 Для того, чтобы создать или адаптировать транспортные соединения ISO для
станции S5...
✔  Используйте функцию “Edit > Connection > Transport Connection” (“Правка > Соединения >

Транспортные соединения”) в COM 1430 TF:
✔  Проверьте следующие условия:

TSAP локальный (S5) = TSAP удаленный (S7)
TSAP удаленный (S5) = TSAP локальный (S7)

                                        COM 1430 TF
Transport Connection

Local Parameters: Remote Parameters:

TSAP (ASC): 0 1 TSAP (ASC): 0 2
TSAP (Hex): 20.20.20.20.30.20.20.32. TSAP (Hex): 20.20.20.20.30.20.20.31.

MAC Address: 08.00.06.01.00.01

Properties - ISO Transport Connection

Cancel
Help

Руководство
/14/
Том 1
Раздел 7

Более подробная
информация
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Загрузка конфигурации соединения в ПЛК
Для того, чтобы загрузить данные конфигурации в станцию S7,
следуйте шагам, показанным ниже:
• Для станции S7, как описано в Разделе 2.
• Для станции S5, как описано в...

Резюме шага 3 ”Конфигурирование транспортного соединения ISO”:
Вы выполнили следующее:
1. Сконфигурировали транспортное соединение ISO между станцией S7 и станцией S5.
2. Загрузили конфигурацию соединения в обе станции.
Станции теперь готовы для обмена данными по интерфейсу SEND/RECEIVE.

Руководство
/14/
Том 1
Раздел 6.4

Более подробная
информация
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1. Создание/открытие Вашего проекта

2. Конфигурирование и подключение к сети аппаратуры

3. Конфигурирование соединений ISO

4. Написание программы пользователя

5. Запуск - Диагностика

Дополнительно:
- OB, FB и HDB используются
со стороны S5.

�
�

�

Задачи в программе пользователя
По сравнению с описанием задачи в Разделе 1, пример д.б. адаптирован для CP 1430 TF
согласно описанию в /14/, как показано:
Данные передаются только станцией SIMATIC 400 в станцию SIMATIC S5, они не
возвращаются, т.к. вызовы передачи в станции SIMATIC S5 и вызовы приема в станции
SIMATIC 400.
Таблица показывает Вам какие блоки типа OB и FB в станции SIMATIC S5, ответственны за
прием данных задания из Станции S7 и обработки их.

Задача в станции S7 Задача в станции S5 Описание задачи в программных блоках
Обработка данных
процесса

Симуляция изменения процессных значений:
OB100
Подготовка блока данных DB30 и DB31. Процессные
значения сохраняются в этом блоке данных.
OB1
Координация работы программы.
FC29
Слово данных циклически инкрементируется и
декрементируется. Интервал времени для
инкрементирования и декрементирования равен 10
секундам.
FC30 / FC5 (AG_SEND)
Слово данных передается в Станцию 2 в качестве текущего
значения процесса (задание).

Прием и обработка
задания

Прием и обработка данных задания:
OB1
Координация работы программы.
FB101 (HDB–RECEIVE)
Сохраняет принятые данные в блоке данных и выводит их
на симуляцию процесса.
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Последовательность программы
В примере блоки OB образуют следующую последовательность выполнения программ в двух
станциях:

AG_SEND

OB1

Обозначение: Последовательность цикла CPU

AG_RECV

ISO
соединение

FC30

FC31

FC29

OB100

Инкрементирование /
декрементирование
слова данных

Запуск

Циклическое
исполнение

 Генерация
блоков данных
DB30 и DB31

HDB-RECEIVE

FB101

Станция S7 Станция S5

OB20 / 21 / 22

FB111

HDB-SYNC

OB1

HDB-CTRL
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Для того, чтобы обработать или загрузить программы станции S7...
...следуйте шагам, описанным в Разделе 2. Информация в Разделе 2 о расширении программы,
например, для анализа кодов состояния вызова, применима так же и здесь.

Для станции S5...
...Вы должны адаптировать программу, чтобы получить требуемую последовательность, как
показано:
✔ Если CP 1430 не синхронизируется во время запуска, это может быть вызвано неверным

OB20. Скопируйте содержимое OB21 в OB20, чтобы HDB–SYNC вызывался правильно.
Используйте программный файл AGAGT2ST.S5D.

Замечание
Убедитесь, что Вы используете соответствующие HDB для заданных CPU в станции S5.
В примере Вам требуются следующие:
HDB–SYNC
HDB–CTRL
HDB–SEND
HDB–RECEIVE

Резюме шага 4 ”Создание программы пользователя”:
Вы выполнили следующее:
1. Создали программы пользователя согласно задачам для обеих станций
2. Расширили пример программы, например, включили анализ кодов состояния
3. Загрузили программы пользователя в CPU обеих станций
Результат:
Чтобы наблюдать передачу данных, следуйте инструкциям в руководстве по CP 1430 TF.
Вы можете наблюдать обновление данных в блоке данных приема в станции SIMATIC S5.

Если Вы не можете обнаружить никакой обмен данным, выполните одно из следующих:
✔ Проверьте последовательность программы в STEP 7/STL online (мониторинг блоков).
Следуйте той же процедуре с программой ПЛК SIMATIC S5 в STEP 5.

✔ Проверьте связь, используя диагностику NCM Industrial Ethernet; смотрите первый пример.

Руководство
/14/
Том 1
Прилож A

Более подробная
информация
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коммуникации, Каталог IK10” и “Программируемые контроллеры
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